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Abstract

Hydrophobicity is a physico-chemical property that may influence the fate of nanomaterials in the
environment and biological matrices. A method to characterise the hydrophobicity of nanomaterials was
developed at the JRC and proposed as an OECD Test Guideline. In this context, the JRC led an Inter-laboratory
comparison (ILC) aiming to assess the transferability of the standard operating procedure. The method is
based on the measurement of the affinity of nanomaterials to engineered collectors. Nine laboratories
participated to this ILC. The variability of the measurements and the reproducibility of the calculation of the
Hydrophobicity Index were assessed according to the International Standard ISO 5725-2. Accordingly, with |Z-
scores| < 2 for all the participants, the determination of the Hydrophobicity Index was considered satisfactory.
The method was adopted by the OECD Working Party of the National Coordinators of the Test Guidelines
Programme in April 2023 as Test Guideline 126.
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Executive summary

The European Commission’s Joint Research Centre (JRC) led the development of an OECD Test Guideline (TG)
for the determination of the hydrophobicity index of manufactured nanomaterials (NMs) through an affinity
measurement. To achieve this result, the JRC collaborated with a group of experts from different institutions
to prepare, execute and assess the entire project, including an inter-laboratory comparison (ILC) study. The
final version of the TG was approved by the OECD Working Party of the National Coordinators of the Test
Guidelines Programme in April 2023.

As agreed during the first meeting of the expert group in October 2019, the JRC organised and evaluated an
ILC on the determination of the Hydrophobicity index of NMs by measuring their affinity for engineered
collectors. (Desmet, 2017, Valsesia, 2018) in collaboration with eight different laboratories from the US and
Europe. The goal of this ring trial was to evaluate the transferability of the SOP to a generic dark field
microscopy (DFM) equipment (different acquisition cameras and microscopes), by the assessment of the
reproducibility of the NMs binding experiments and the calculation of the corresponding Hydrophobicity index.

This ILC was launched in November 2020 and concluded in October 2021. Nine laboratories from the US (2),
France, Germany, the UK, Greece, Italy, Portugal and the JRC-Ispra participated in this ring trial by analysing a
minimum of three different materials randomly attributed, out of the five selected. This choice was made to
save time to each entity while keeping a consistent number of results for each material. In particular, one
material was tested by all the laboratories, while all the other materials were tested by a minimum of five
participants, with three independent replicates for each material. The following materials were considered:
naked polystyrene and carboxylate polystyrene particles (commercial references), gold nanoparticles
stabilised with citrate, hydrophobic TiO, nanoparticles stabilised with natural organic matter (from the JRC
Nanomaterials Repository) and the commercial food additive TiO, (E171). All materials were fully
characterised in the JRC Nanobiotechnology Laboratory before shipment to the ILC participants.

Despite the novelty of the method and the differences in the used instrumentation, the nine laboratories were
able to detect the NMs by DFM and reported measurements in triplicate. One material was discarded because
it was not detectable by any participant after shipping, probably due to stability issues. The data analysis
procedure was not assessed in the ILC and was optional for the participants. The JRC determined the binding
rates of the NMs on the different collectors by analysing the image sequences of DFM acquired by the
participants. The Hydrophobicity index was then calculated as the final result of the test. The reproducibility
was considered satisfactory according to the International Standard ISO 5725-2, as all |Z-scores| were
determined to be < 2.



1 Introduction

Hydrophobicity is a relevant property for understanding the behaviour of nanomaterials or other chemicals in
terms of safety assessment. In fact, hydrophobicity is currently listed as a key physicochemical parameter in
the OECD Draft Physico-chemical Decision Framework for Manufactured Nanomaterials (OECD, 2019).
Hydrophobicity provides information on the affinity of nanomaterials to aquatic and terrestrial organisms
(including bioaccumulation and persistence) and to human cell surfaces (including entry into the body through
the skin and lungs and subsequent accumulation in or removal from tissues/organs) and blood. An ISO
technical report (ISO, 2019) also mentions hydrophobicity/hydrophilicity as one of the physico-chemical
properties determinant for toxicokinetic behaviour of nanomaterials, since it has an impact on surface
chemistry, protein corona formation and accumulation. It can be used as an indicator of the fate and
transport of a chemical in the aquatic environment and as a parameter in environmental exposure models to
estimate soil and sediment sorption, bioavailability, and bioconcentration/bioaccumulation in aquatic
organisms. It can also play a role in (eco)toxicity prediction (e.g. in (Q)SAR modelling) and help assess
bioaccumulation potential (e.g. for PBT assessment) and predict environmental fate and concentrations in
exposure models.

In its nano-specific guidance for the implementation of the REACH regulation, the European Chemicals Agency
(ECHA) proposes a series of descriptors that may be used to predict the fate and transport of nanomaterials
in environmental and biological media. These descriptors are: 'agglomeration, aggregation, deposition and
attachment' (ECHA, 2022), all of them influenced by surface hydrophobicity (among other physicochemical
properties). Hydrophobicity is also included in the list of potentially relevant parameters to justify the
application of grouping and read-across principles to nanoforms of the same substance under REACH (ECHA,
2019). However, it is recognised that "analytical determination of the hydrophobicity of nanoforms is still
under development, e.g. sessile drop contact angle, dye adsorption"” (ECHA, 2019). Indeed, existing
standardised quantification methods are not suitable for nanomaterials, as suggested by the OECD Working
Party on Manufactured Nanomaterials (WPMN) (e.g. OECD, 2009, 2014, 2017) and the research community
(e.g. NANOREG, 2015).

The JRC (Directorate Health and Food, Technologies for Health Unit, F.2) coordinated the development of an
OECD Test Guideline (TG) for the determination of the Hydrophobicity index of nanomaterials through an
affinity measurement. The method is based on the measurement of the binding rates of nanomaterials to
engineered hydrophobic and hydrophilic surfaces (collectors). It is an alternative to the other potentially
applicable techniques. A standard operating procedure was designed by the JRC, in collaboration with a group
of experts from different countries, and tested in several laboratories in an inter-laboratory comparison
exercise, to assess the transferability of the method. The ILC study reported here was carried out to support
the adoption of the new OECD TG 126.



2 Methodology

The purpose of the inter-laboratory comparison (ILC) was to assess the applicability and transferability of the
proposed method to determine the hydrophobicity index of NMs by affinity measurements. See Appendix 1 for
the definition of hydrophobicity index.

The planning of this ILC was discussed for the first time in an "Expert Meeting to Develop an OECD Test
Guideline to Determine Surface Hydrophobicity of Nanomaterials" held at the JRC in Ispra in autumn 2019. In
January 2020, interested laboratories were contacted to participate in this experimental exercise, which was
planned to begin in April 2020. Due to the Covid-19 outbreak, the start time was postponed and all
participants were contacted again in late summer 2020 to confirm their participation. The ring trial effectively
started in November 2020, with the sending of test samples, standard operating procedure (SOP) and files for
data treatment. Results were expected in the second quarter of 2021, but due to Covid-19 related issues and
the defection of some laboratories, an extension was decided as well as involving new laboratories. The end
date was moved to the beginning of the fourth quarter.

Five material samples were selected for the ILC based on their ‘presumed’ hydrophobicity. First, the JRC
developed the SOP and conducted experimental tests on the selected materials. The JRC sent test kits
containing samples, collectors, camera setup calibration platforms, memory sticks containing the SOP, and
Excel files containing macros for data reporting and analysis to all participating laboratories. The nine
laboratories that effectively participated in this exercise are listed in Table 1.

Table 1. Laboratories participating in the ILC

Participant Country

Food and Drug Administration (FDA) United States
National Institute of Standard and Technology (NIST) United States
Institut des Sciences Analytiques et de Physico-Chimie pour France
’'Environnement et les Matériaux (IPREM)

Badische Anilin- und Soda-Fabrik (BASF) Germany
International Iberian Nanotechnology Laboratory (INL) Portugal
Istituto Italiano di Tecnologia (IIT) Italy
Birmingham University (BHAM) United Kingdom
Foundation for Research and Technology-Hellas (FORTH) Greece

Joint Research Centre (JRC) European Commission

2.1 Test materials

In order to assess the applicability and the reproducibility of the proposed method, an initial list of seven
materials with different characteristics (i.e. size, chemical composition, physical state) was selected for the
inter-laboratory exercise. Due to the time constraints, the list was shortened to the five materials described in
Table 2.




Table 2. Selected materials for the ILC

Sample | Type of material Mean size diameter (nm) Source

M1 Polystyrene (hydrophobic) 500 (commercial reference) Polysciences, Inc.
M2 Hydrophobic gold NPs in citrate 70 JRC laboratory
M3 Carboxylate Polystyrene (slightly hydrophilic) | 500 (commercial reference) Polysciences, Inc.
M4 Hydrophobic TiO; Rutile 21 (primary size) JRC repository
M5 TiO; Anatase, E171* 20-300 Farmalabor

*Farmalabor technical datasheet

The JRC sent samples of a minimum of three different materials selected from the five shown in Table 2 to
each participant laboratory. The M2 and M3 samples were analysed by five laboratories, M4 and M5 by six
laboratories and M1, which was also used as a standard control material to assess the collectors’ properties,
by all the participants.

Despite M1 and M3 are not strictly nanomaterials (i.e. diameter >100 nm), they were chosen as control
samples (one hydrophobic and one hydrophilic) due to their large light scattering intensity, which makes them
easily detectable in Dark Field microscopy (DFM). Because of the direct relationship between the scattering
property and the type and size of a material, only nanomaterials with a significant light scattering intensity
can be selected as control.

Table 3. Materials distributed to the ILC participants

Lab. M1 M2 M3 M4 M5
1 X X X X X
2 X X X X X
3 X X X
4 X X X
5 X X X
6 X X X
7 X X X
8 X X X
9 X X X

The material was dispersed in an aqueous solution of fixed ionic strength (phosphate buffer (PB) 10 mM, pH
7) to perform the test. Materials M1, M2 and M3 were provided to participants as dispersions while material
M4 and M5 were provided as powders together with the buffer in which they had to be be dispersed and the
dispersion protocol. The M4 powder was not dispersible directly in PB, therefore a stabilising agent was added.




2.2 Collectors and Samples characterisation

The collectors’ surfaces were characterised using several techniques. The thickness and refractive index of
each deposited layer were measured by Ellipsometry (Vase VUVTM J.A. Woollam Co., United States). The
contact angle of the modified glass slides was measured by using a DigidropTM goniometer (GBX Scientific
ltd, France) with a water droplet. Finally, a control test based on DFM with a known commercial standard
sample (Polybead® Polystyrene Microspheres 0.5 um, Polysciences, Inc., United States), was performed.

The size measurement of M1, M2, M3, M4 and M5 samples was performed by Dynamic Light Scattering (DLS,
Zetasizer, Malvern Panalytical, UK). Size distribution and {-potential were measured in 10 mM phosphate
buffer pH 7. All the measurements were repeated several times over a period of 2 weeks in order to
guarantee the stability of the samples.

2.3 Samples distribution

The subsampling of the materials was carried out in the JRC Nanobiotechnology Laboratory. The test kit
(collectors and samples), together with the SOP and the data reporting files, were sent to participants in
different periods of 2020/2021, according to their availability to perform the measurements.



3 Ring trial results and considerations

All the participant laboratories tested three materials. The measurements were performed in three
independent replicates for the materials M1, M3, M4 and M5. The material M2 (citrate stabilised gold
nanoparticles) was not detectable by any of the involved laboratories (except JRC) due to colloidal stability
issues related to the shipment conditions (most probably due to uncontrolled temperature variations). For this
reason, the results obtained with sample M2 are not included in the inter-laboratory comparison results
presented below.

The objective of the inter-laboratory exercise was to assess the method performance (i.e. transferability) and
demonstrate that the SOP is reproducible and robust, regardless of the DFM setup (microscope trademark,
light sources, optical configuration, camera, etc.). As explained in the SOP, the data treatment was only
optional for the participant, and the result obtained from their calculation was not assessed in this ILC. The
JRC processed the results of the ILC in two main steps, as presented in Figure 1. The image sequences
recorded in DFM and sent by the participant were analysed to determine the binding rates for the four
materials on three collectors (Step 1). The Hydrophobicity index was then calculated (Step 2).

Figure 1. Calculation flowchart

Step 1 Step 2
experimental  calculation

Pl

Hydrophobicity

The experimental results were assessed for different purposes:

1. To demonstrate the capability of the optical setup to visualize and detect individual particle of the
material M1.

2. To measure the binding rates of the materials onto the three different collectors, which allows the
assessment of the reproducibility of method.

3. To calculate the hydrophobicity index from the experimental data.

3.1 Detection of the sample M1 by DFM

The assessment of the particle binding rate on the collector was based on the ability to detect the presence of
particles by DFM, using the image analysis software Fiji (Schindelin, 2012) with the plugin Trackmate (Tinevez,
2017). For correct detection of individual particles, DFM settings (light intensity and focus) and camera
parameters (exposure time and gain) must be optimised according to the SOP.

A single M1 particle is considered detected when light scattered by the particle hits on multiple pixels on the
camera sensor. The number of pixels and intensity of illumination depend on many factors such as: resolution,



sensitivity, dynamic range and dark noise of the camera sensor, irradiance of the light source, quality of optics
(lens and any intermediate optical components in between), the accuracy and stability of the focusing stage,
any optical aberrations, and any dust contamination on the surface of the liquid cell. Thus, it was important to
ensure that all participant laboratories were able to generate similar and relevant “images” that allow to
detect with appropriate resolution the attached particle. This was done using M1 as reference sample.

Assuming that the scattering particles are point sources of photon scattering, the real image produced on the
camera sensor consists of one large spot due to the diffraction limit of light. The image of the particle takes
the form of a Point Spread Function (PSF). At the focal plane, the PSF can be fitted to a 2D Gaussian
distribution (Stallinga, 2010, Zhang, 2007).

In Figure 2, we show the X-sections of typical M1 particles detected at the collector surface corresponding to
the focal plane, obtained by the different participants. All X-curves fit Gaussian curves (MSE or chi-square
>0.6 in all cases), indicating that all DF settings (as described in Table 4) allow detection and resolution
of a single M1 particle on the surface of the collector according to the suggested SOP.

Figure 2. X-profile of a single M1 particle obtained by the participants and the relative Gaussian fit

-

In the insets, the relative image collected on the camera.



Table 4. Summary of the optical setups and the measured resolution of a single M1 particle for each participant

Participant | Microscope | Configuration | Camera (res in | 100*FWHM! | M1 single
(Reflection Mpixel) (pixel™?) particle
[Transmission) detected

Labl LEICA R Basler acA4600-10uc 103 Yes
DMRME

Lab2 LEICA / Basler ace 5.1MP Color 1.06 Yes
DM/LM

Lab3 OLYMPUS / OLYMPUS QColor5 CCD 2.02 Yes
BX61

Lab4 LEICADMRX | T OLYMPUS UCS0 0.98 Yes

Lab5 LEICA / DFC 450 127 Yes
DM6000

Lab6 NIKON / Color Camera Head DS- | 0.74 Yes
ECLIPSE Fi2
LV100 ND

Lab7 ZEISS / CANON 550D 133 Yes
Axioskop 40

Lab8 LEICA R Thorlabs DCC1545M 1.15 Yes
DM2500M

Lab9 NIKON T SMX-150M-E 25 Yes
ECLIPSE
E800

A direct measurement of the lateral resolution can be obtained by inversing of the Full Width at Half
Maximum (FWHM) value of the fitted Gaussian curve. This value is reported for all the participants in Table 4.
The lower the value for FWHM™ the lower is the resolution of the optical system (Zhang, 2007). The average
value for FWHM™ for all the participants is 0.013 + 0.007 pixel™. Only one participant showed a value of the
FWHM close to the standard deviation limit (in italic in the table), indicating a poor resolution of the used
optical system.

3.2 Evaluation of the reproducibility of the particles binding experiments

To assess the inter-laboratory reproducibility of the particles binding experiments, the JRC provided the
participant labs with a set of collectors and materials, previously characterised and tested in the JRC
laboratory.

Since the most important parameter of the collectors influencing the particles binding is the hydrophobic
character (together with the surface  potential), the water contact angle (WCA) of the different collectors was
measured. Other quality control parameters such as the thickness of the fluorocarbon layer (PTFE, TO) and the
layer refractive index were also measured for every batch of collectors produced. The variability of the WCA
for the different collectors prepared by the JRC and shipped to the different participants is shown in Figure 3.
The nine batches correspond to the nine laboratories participating to the ILC.
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Figure 3. Variability of the WCA for the different collectors

Mean Mean
CA-TO o Z-Score CA-TS o Z-Score
L 105.69877 L] 64.69753
batchg } B a batch9 >—~—< = [m]
batch8 I B | batchg 7}4 1o
batch - } 1 o batch7 - »—‘— 1 o
batché | 1 o batché - + 1.
batchs —4 0 batchs —.—4 = o
batchd I 4 o batch4 - H"—1 R o
batch3 - »——I»—« - [m] batch3 — A [m]
batch2 ; } i 4 5] batch2 + + E a
batch1 :’»A —10 batch1 Jr 4 0
T T T T | T — T T T T | T —
100 102 104 106 108 Mo-2-10 1 2 40 50 60 70 80 90 -2-10 1 2
WCA (°) WCA (%)
Mean
CA-T4 o Z-Score
L 44.60864
batchg |—~|—4 - m}
batchs P—‘»—l B u|
batch7 - H 4 O
batché El»a 4 O
batchs o + — a
batchd .—|—< 1 c
batch3 H B o
batch2 + 4 =]
batch1 4 + 4 o
T T T T 1 T T 1
20 30 40 50 60 70 -2-10 1 2
WCA (°)

The variability of the WCA for the collectors has been assessed with Z-score evaluation. Contact angles of all
the collectors produced showed an absolute value for the Z-score lower than 2, indicating a good
reproducibility of the fabrication technique. The variability range does not affect the binding rates
measurements, as the analysis of the results shows no correlation between these variables.

The particles binding experiments were conducted by the laboratories according to the SOP, included as Annex
1 to this report. All experiments were performed in three independent replicates and the binding rates
calculated by averaging six areas for each image sequence. The output of the binding experiments is the time
sequence of images of the collector’s surface showing the moving particles and the bound particles at the
focal plane. The sequence of images is then analysed using a combination of Fiji and its TrackMate plugin.
This tool enables the identification of the particles irreversibly bound on the collectors as a function of the
exposure time. The number of binding particles as a function of time is plotted in the binding curves. These
curves show a linear dependency on the square root of the time, as predicted by the theory of diffusion of
particles dispersion. The slope of the binding curve on the different collectors represents the velocity of
binding vy and is measured in number of Nanomaterial (NM) bound per unit of time NM/s'2,

vy, according to the XDLVO theory (Donaldson, 2015) is directly influenced by the energy barrier occurring
between the particles and the surface as explained below.

— vro: binding rate on the hydrophobic collector TO is directly related to the hydrophobicity of the particles

— vrs: binding rate on the collector with opposite charge compared to the particles (T5 for the material
tested in this ILC), where the electrostatic forces are dominant, represents the maximum binding

12



— vq4: binding rate on the hydrophilic collector with the same charge of the one of the particles (T4 for the
material tested in this ILC) represents the binding velocity close to zero in the presence of a high energy
barrier

The values of vy measured using the images collected by the different ILC participants, for the different
materials and on the three different collectors are shown in Table 5.

13
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Table 5. Inter-laboratory results for the binding rates for the different materials on the different collectors

Vro STD SCZO' o V1a STD | Z-score | Vs STD Sczo're Vro STD Sczo're Vrs STD Sczo're Vrs STD Z-score
M1 M3
Labl | 0533 | 0182 | -0439 | 0340 | 0293 ! 3527 | 0200 | 0523 | 0967 | 0359 | 0101 | 0060 | 0078 | 0900 | 4727 | 3.395 0.580
Lab2 | 0410 | 0216 |-0608 | 0013 | 0006 | 0219 | 3457 | 0202 | 0359 | 0897 | 0491 |-0040 | 0017 | 0012 | -0660 | 3610 | 0.075 0.044
Lab3 | 1027 | 0825 | 0238 | 0020 | 0000 | 1708 | 3263 | 0227 | -0.094 | 0990 | 0295 | 0.148 | 0037 | 0025 | 0060 | 3220 | 1876 | -0.143
Lab4 | 1423 | 1427 | 0783 | 0010 | 0000 | -0525 | 3.183 | 0897 | -0.281
Labs | 0970 | 0759 | 0.61 | 0050 | 0.020 ! 2070 | 0.394
Lab6 | 0247 | 0012 | -0832 ] 0010 | 0000 | -0525 | 0640 | 0468
Lab7 | 0963 | 0755 | 0151 | 0013 | 0006 | 0219 | 3423 | 0012 | 0281 | 1383 | 0501 | 0939 | 0067 | 0021 | 1.140 | 3297 | 1054 | -0.106
Lab8 | 0803 | 0910 | -0068 | 0010 | 0000 | -0525 | 2547 | 2227 | -1771 | 0347 | 0330 | -1.147 | 0020 | 0017 | -0540 | 2737 | 2356 | -0375
Lab9 | 1300 | 0087 | 0614 | 0.137 | 0.170 - 2967 | 0397 | -0.788
M4 M5

Labl | 0250 | 0036 |-0077 | 0093 | 0006 | 0829 | 1083 | 0295 | 1.024 | 0.133 | 0058 | -0538 | 0037 | 0006 | 0960 | 1967 | 0404 | 0648
Lab2 | 0253 | 0032 |-0033 | 0077 | 0107 | 0355 | 0667 | 0050 | -0209 | 0240 | 0174 | -0256 | 0017 | 0012 | -0611 | 1667 | 0084 | 0072
Lab3
Lab4a | 0247 | 0136 |-0121 ] 0027 | 0029 | -1066 | 0477 | 0214 | -0771 | 0773 | 0593 | 1.155 | 0020 | 0017 | -0349 | 2.100 | 0580 0.904
Lab5 | 0173 | 0006 |-1.093 | 0035 | 0035 | 0450 | 0440 | 0137 | -0880 | 0.183 | 0006 |-0406 | 0017 | 0006 | -0611 | 1.590 | 0104 | -0.075
Lab6
Lab7
Lab8 0.163 | 0071 |-0459 | 0020 | 0010 | -0349 | 0967 | 0667 | -1270
Lab9 | 0347 | 0040 | 1.203 | 0015 | 0015 | -0213 | 1020 | 0161 | 0836 | 0527 | 0546 | 0503 | 0037 | 0006 | 0960 | 1483 | 0214 | -0279




The statistical analysis of the ILC data was performed using the dedicated software Prolab (Quodata,
Dresden), according to the International Standard 1SO 5725-2. The basis for scoring of the results is the "Z-
score". The Z-score of all the results from the participating laboratories, including those eliminated as outliers,
is calculated with the aid of the outlier-free mean value and the outlier-free standard deviation. It can be
regarded as the quality characteristic of the mean value of the individual laboratories. The analysis is based
upon the following formula:

Z=(C-G)/s
Gy’ = individual mean value
Cx = Total mean value/reference value

s = Maximum permissible deviation from the reference value (as a rule 10%)

A permissible deviation of 10% is assumed for s during analysis of the Proficiency Testing (PT) scheme.
Where data material exhibits strong scatter the permissible deviation may be increased to up to 20%. The
individual results are then evaluated as shown below:

— 12| £ 1 Good result
— 1 <|Z| < 2 Satisfactory result
— 2 <|Z| < 3 Questionable result

— 3 < |Z| Extremely questionable result

A result for which |Z] < 2 is deemed satisfactory, i.e. the PT is deemed passed. Should the Z-score exceed 2,
review of the analysis method employed is advisable. The Z-score can be used to determine further
statistically important parameters, which shall not however be considered in any greater detail at this point.

The large majority of measurements are providing a |Z-score| < 2 for all the tested materials on the TO and
T5 collectors, which allows considering the obtained results satisfactory. Only two measurements (Lab5 and
Lab6 measurements of M1 on T5) have a higher Z-score which underlines the presence of an error affecting
the measurement. For example it is possible to relate the underestimation of the binding rate on T5 for M1
for the Lab6 to a poor resolution of the optical configuration used (as shown in the evaluation of the FWHM
presented in table 4). Another explanation could be an accidental occurrence, as the lack of focus, or the
presence of some interferences on the optical path. The higher Z-scores obtained on the collector T4 for M1
are not considered relevant since this collector is only used as a negative control for the tested materials (the
collector’'s surface being negatively charged in the measurement conditions, as the tested materials), and
provides a very low binding rate.

As a general comment, all the materials on the different collectors behave according to the expectations
predicted by the XDLVO theory, with a maximum binding rate on T5, a binding rate close to zero on T4 and a
variable binding rate on TO, depending on the material’s hydrophobicity.

3.3 Evaluation of the reproducibility of the calculation of the Hydrophobicity
index

The binding rates are used for calculation of the hydrophobicity index Hy. It is defined as the logarithm of the
ratio between the values of the binding rate on the hydrophobic collector v, and on the hydrophilic collector
inducing electrostatic attractive forces vmax (T5 for negatively charged material as it is generally the case in
the medium of measurement and T4 for positively charged material). The closer to zero the more hydrophobic
a NM is considered.
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The ILC data on the hydrophobicity index for the different materials are shown in Figure 4.

Figure 4. Inter-laboratory variability charts for the Hydrophobicity index Hy for the different materials
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The main conclusion that can be drawn from figure 4 comes from the |Z-scores|, which are all < 2, thus
demonstrating satisfactory results for the calculation of the Hydrophobicity index for all materials and all
participants. It should also be noted that 23 out of the 25 |Z-scores| determined are < 1, which corresponds to
a good result for the proficiency test according to 1ISO 5725-2. Moreover, experimental variations such as the
particles concentration, that could affect the reproducibility of the binding rates on the different collectors,
are not affecting the reproducibility of the Hy since it is calculated from the ratio of the binding rates. This is
reflected by the absolute values of Hy for the Z-scores < 2 for all materials.

As a general comment, according to the Z-score calculated for each data produced by the different
participants, the reproducibility of the binding curves and the relative calculation of the hydrophobicity index is
considered to be satisfactory.

Two other important results should be underlined:

— all the participants were able to detect the different materials with their microscope and camera setup,
by following the SOP

— no correlation was observed between the WCA (fig 3.) for the collectors and the measured data

These two points demonstrate that the experimental setup of the SOP is robust. This is reflected in the good
reproducibility of data according to the statistical evaluation using the Z-scores.
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4 Conclusions

Nine laboratories participated in this ILC to determine the hydrophobicity index of nanomaterials through
affinity measurements. Despite differences in detection systems (cameras and microscopes), all participants
were able to detect and resolve particles of materials M1, M3, M4 and M5 following the proposed SOP, while
one material (M2) was not detectable and quantifiable by the involved laboratories due to sample stability
issues. Specifically, for sample M1, it is possible in all cases to fit the particle scattering curve with a Gaussian
curve (MSE > 0.6). Furthermore, when analysing the mean FWHM values for the fitted Gaussian, we found
that only one participant obtained a value close to the STD limit due to a lack of resolution.

The WCA values shown in Figure 2 emphasize the very good repeatability of the collector fabrication
technique.

The reproducibility of particle binding experiments for different materials on the three different collectors was
satisfactory, as indicated by the calculated Z-score values (with two exceptions for M1 on T5). All tested
materials on the different collectors showed behaviour consistent with the predictions of the XDLVO theory,
with maximum binding on T5, close to zero binding on T4 and variable binding on TO depending on the
material’s hydrophobicity.

The reproducibility of the calculation of the hydrophobicity index Hy was also assessed. Data collected were
satisfactory, with an absolute value for the Z-score < 2.

We may also conclude that organising training on DFM use and sharing best laboratory practices could help to
improve unsatisfactory results and optimise the application of the TG for future users.
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Annexes

Annex 1. Standard operating procedure (SOP) for the determination of the hydrophobicity index of
nanomaterials according to the advanced draft test guideline

1. OBJECT AND SCOPE

This Standard Operating Procedure (SOP) aims at the determination of the surface hydrophobicity of
manufactured nanomaterials as dispersed in an aqueous solution. It is intended for the sole use in an inter-
laboratory test exercise to ascertain the transferability and reproducibility of the method described in the Test
Guideline in preparation, in particular the measurement protocol. The data treatment is also included but will
not be part of the assessment of the ILC.

The surface hydrophobicity of the nanoparticles dispersed in water is determined by measuring their binding
rate to different engineered surfaces (collectors). The method is based on two articles, published by Desmet
et al. (2017) and Valsesia et al. (2018), where the measurement of the binding rates of the nanoparticles to
the engineered collectors is used to mathematically derive the polar component of their surface free energy,
according to the XDLVO (eXtended Derjaguin Landau Van Overbeek) theory.

2. TERMS AND DEFINITIONS

For the purpose of this procedure, the following abbreviations and definitions apply:
DF Dark Field

DLS Dynamic Light Scattering

AGM energy barrier

v polar component of the surface free energy of the particle
g gram
kT product of Boltzmann constant and temperature

hydrophobic interaction distance

m metre

Ms sample mass

MQ MegaOhm, electric resistance
mol mole

nm nanometre

PB phosphate buffer

PDDA poly(diallyldimethylammonium chloride)
PE polyelectrolyte

PSS poly(sodium 4-styrenesulfonate)

PTFE polytetrafluoroethylene

p density (g/cm®)

RMS root mean square

SOP Standard Operating Procedure

T0 PTFE-like Hydrophobic collector
T4 Hydrophilic and negative collector (PTFE-like + 4 PE layers)
T5 Hydrophilic and positive collector (PTFE-like + 5 PE layers)
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v velocity of adsorption

Vimax maximum velocity of adsorption
Veell sample chamber volume (cm?)
Vief reference chamber volume (cm?)
wt weight percent

XDLVO  eXtended Derjaguin Landau Van Overbeek

Zi particle-collector distance

3. PRINCIPLE OF THE TEST

The test enables the quantification of the polar component of the surface free energy of nanomaterials and,
consequently, of their surface hydrophobicity. This is achieved by measuring the binding rate of the dispersed
particles to different engineered surfaces called collectors and by transferring these experimental values into
a system of equations derived from the XDLVO theory for spherical particles (Desmet 2017, Valsesia 2018).

A collector is characterised by the following properties:
— Low surface roughness (Root Mean Square roughness < 5 nm)
— A certain value of the polar component of the surface free energy

— A certain value of the streaming potential

The particles are dispersed in an aqueous medium in conditions of colloidal stability (according to OECD TG
318). The dispersion is brought to the collectors by means of a liquid cell and allowed to approach to the
collector surface by diffusion. The number of particles binding to the collector as a function of time
determines their affinity to the collector. The counting of bound particles as a function of time is done by Dark
Field microscopy and a camera. The Trackmate plugin of Fiji software is then used to automatically detect the
particles and to build the binding curves. The test returns the number of particles binding as a function of
time on the different collectors.

As a first result of the method, these experimental data can be used to qualitatively assess the nanomaterial
hydrophobicity (Desmet et al. 2017, Valsesia et al. 2018). As a general indication, the larger the affinity to a
hydrophobic collector is, the higher the nanomaterial hydrophobicity is.

The binding rate of the NMs to the different collectors is regulated by the XDLVO forces, where Hydrophobic
forces are added to the DLVO model) and kinetics limitations imposed by the diffusion of the NMs (16). The
XDLVO interaction energy between NMs and surface determines the formation of an energy barrier inhibiting
the binding. The XDLVO theory applies to stable NM dispersions in aqueous samples.

When the energy barrier is comparable with the thermal energy, the NM is able to bind to the surface in a
stable thermodynamic state. This happens when Van der Waals or hydrophobic forces can counterbalance the
electrostatic repulsion. When the electrostatic forces are attractive, the only factor limiting the binding rate of
the particles to the surface is the transport of the particles. The reaction balance can be written as:
[NM] + [S] = [NM —S]
Where [S] is the binding site on the surface and [NM — S] is the complex nanomaterial-binding site. The
equilibrium constant of the reaction is the proportion of the products and the reactants:
Keq = [NM — S]/(INM] + [S])

The equilibrium constant Keq cannot be determined since the reaction occurs only in one direction. Thus, it is
impossible to determine the interfacial Gibbs free energy of adhesion using a single surface. The
thermodynamic relation between the Gibbs free energy and the equilibrium constant is expressed by the
equation:

AGO = —kTInKeq
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Where k is the Boltzmann constant and T the temperature. On the other hand, A4GO is the limiting parameter
that inhibits the binding of NMs to the surface. According to the Boltzmann distribution the binding rate on a
surface is:

v = vmaxe (4GO/KT)

where vmax is the maximum binding rate (for a spontaneous reaction limited only by the transport of the
particles to the surface). Thus, AGO/kT is:

—AGO/kT = In(v/vmax)

A Hydrophobicity index (Hy) is defined, based on the affinity of the material for the hydrophobic collector as
compared to a hydrophilic one which favours the electrostatic attraction forces (the reference collector on
which the binding velocity is maximum). Hy can be expressed as:

Hy = log(vy,/vmax)

Hy is a direct measurement of the tendency of the NM to bind to the hydrophobic collector, rather than
staying in the aqueous phase, which is directly related to the NMs hydrophobicity character.

In the method, vy, is the binding rate on the hydrophobic collector, which is directly related to the
hydrophobicity of the NM, i.e., where binding is driven by hydrophobic interactions between the NMs and the
collector. vmax is measured on the collector on which the binding rate is maximised by favouring
electrostatic interactions. NMs being in most cases negatively charged in the measurement conditions, the
binding rate to the hydrophilic positively charged collector is only limited by the NMs transport to the surface.
For positively charged NMs the binding rate on the hydrophilic negatively charged collector is used instead.

Since vHy/vmax is always < 1, the Hy values are always < 0. Hy values close to zero, indicate a high
affinity to the hydrophobic collector (as show in figure 2), i.e., particles behaving as hydrophobic chemicals. As
an indication, a NM is considered hydrophobic when the value of this index is between 0 and -1, while a
hydrophilic one shows values lower than -1. The closer to O the Hy is, the more hydrophobic the NM is.

24



Figure 2. Principle of the method for the quantification of the hydrophobicity index of NMs. The NMs in stable
dispersion are allowed to approach the collector by diffusion. (a). The energy balance described by the XDLVO
theory drives the stable binding of the hydrophobic NM to the hydrophobic collector (situation in column 1),
while the hydrophilic NM is repelled (situation in column 2) (b) The square root of the number of bound
particles is presented as a function of the square root of time. The binding rate on the hydrophobic collector
vHy is plotted for the NMs with respect to the maximum binding rate vmax occurring when the electrostatic
forces are dominating. The closer the slope for vHy is to vmax, the more hydrophobic a particle is.
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4. SAMPLES, REAGENTS, EQUIPMENT AND MATERIALS

Nanomaterial samples

Samples of nanomaterial dispersions will be sent by the JRC to the participating laboratories. Material M1
(control sample) will be sent to all the participants, while the other four materials will be distributed randomly
in order to have a desirable number of results for each material.

Material needed for binding rate measurement

— 3 collectors, one of each type

— Nanomaterial samples, dispersed in Phosphate Buffer (PB), 10 mM, pH 7
— Vortex

— Calibrated pipettes (0.02 mL volume)

— Microscope with Dark Field configuration (either in reflection of transmission mode), equipped with a
camera and a 10x objective
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5. SAMPLE PREPARATION

The JRC will provide ready-to-use collectors. They will come numbered for traceability and protected in
individual re-sealable plastic bags.

— Collector 1: TO, fluorocarbon coated glass slide, hydrophobic
— Collector 2: T4, PTFE coated glass slide + 4 polyelectrolyte layers, hydrophilic and negatively charged
— Collector 3: T5, PTFE coated glass slide + 5 polyelectrolyte layers, hydrophilic and positively charged

Nanomaterial preparation

Dispersion of the nanomaterial

To perform the test, the material has to be dispersed in an aqueous solution of fixed ionic strength. It is
recommended to use a dispersion protocol that guarantees stability of the colloidal dispersion (according to
OECD TG 318) without modification of the surface properties and chemical nature (e.g. coating) of the
particles. Material 1, 2 and 3 are provided as dispersions. Material 4 and 5 are provided as a powder together
with the buffer in which it should be dispersed.

Characterisation of the nanomaterial

The obtained dispersion solutions have been used for the characterisation of the NM before sending. Size
distribution and {-potential were measured through Dynamic Light Scattering and Transmission Electron
Microscopy. For comparison purposes, aliquots of all samples have been tested at the JRC prior to sending,
using the proposed method for hydrophobicity determination.

6. OPERATING PROCEDURE

You will use Fiji for the different steps of the procedure. If Fiji is not installed on your computer, you can find
it in the USB drive, in the Tools for data treatment folder. To install it, go to the Fiji.app folder and double click
on Fiji-win64.exe.

Measurement of the nanomaterial binding rate to the collectors

Calibration of Fiji

A calibration of both the microscope’s camera and Fiji must be done before performing the experiments with
the material. First, the Calibration chip is used to calibrate Fiji for further image treatment as described in the
following steps.

a. Place the chip under the 10x objective of a DF microscope connected to a camera. When using a
transparent substrate (e.g. glass), both transmission and reflection mode are possible depending on
the highest contrast obtained. To use the microscope, please refer to the equipment user's manual.

b. Adjust the focus on the centre of the chip with the 10x objective and save an image as
“Size_Calibrant” in Tiff format in the Calibration folder.

c. Open Fiji and in the File menu choose Open and select your Size_Calibrant image.
d. Draw a line using the Straight tool, of the same length as the square as shown in figure 2.

e. In the Analyze menu, select Set Scale and fill in the boxes “Known Distance” = 135.00, “Unit of
length” = um, “Global” = ticked.
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Fiji is now calibrated for all the images and must be kept open (if closed, the calibration must be
repeated). Alternatively, if your camera provides a calibration bar, it can be used for calibration.

Figure 2. Size calibration in Fiji
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Setting up of the microscope and camera

To set up the microscope and camera, the TO collector is used. A line has been drawn in the middle of the
slide on the whole length, crossing all the channels. This line will be used to adjust the focus on the surface.
The first channel on the left side is sealed and must not be opened. It contains particles bound to the surface
of the collector and serves as a calibration specimen for setting up the parameters of the microscope and
camera (coarse focus, illumination intensity, exposure time, contrast, etc.). In order to check the quality of
your set up, follow the steps described below

a. Position the first channel under the objective and adjust the focus on the line in the middle.

b. Move the microscope stage to position the line at the top or bottom of the field of view and re-
adjust the focus on the bright dots, which are particles bound to the surface. The optical zoom of
the camera software can be used for a finer adjustment of the focus.

c. Optimize light illumination of the microscope and exposure time of the camera. Disable all
automatic adjustments of image quality from the camera software (only adjust the exposure time,
example of parameters used with the camera software of JRC are provided in the USB drive in the
Example folder). When satisfied with the quality (you can observe clear bright spots on a dark
background), register an image as “Setup Evaluation” in Tiff format and save it in the Calibration
folder. You can proceed to the evaluation of the quality of your image.

d. Use Fiji (already opened in the previous calibration step) to open the image: File menu, Open your
Setup Evaluation image. The image should be sized in um x pm as shown in figure 3 (if not, the
calibration step described above was not saved and should be repeated on the previously saved
Calibration image).

e. Transform the image format: in the Image menu, Type, select 8-bit.

f. Zoom on an inter-particles area, select the area (pay attention not to include any particle) with
the Rectangle tool and specify a size of 10 x 10 pm? as in the figure below using the Edit menu,
Selection =» Specify.
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Acquire the histogram of the selection using the Analyze menu, Histogram.
Open the Setup Evaluation excel file and annotate background Mean and StdDev values.

Zoom on one of the closest particle and select its centre with the Rectangle tool, specify a size
of 1 x 1 ym? using the Edit menu, Selection =» Specify.

Acquire the histogram of the selection as previously done and annotate Mean value in the Setup
Evaluation excel file. Your setup (microscope and camera) is satisfactory if the result given in the
Setup Evaluation Excel file is >10.

If quality check is not satisfactory, please contact us before proceeding with the rest of the
experiments.

Figure 3. Evaluation of the Microscope and Camera set up in Fiji
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Dark Field measurement of the nanomaterial binding rate to the collectors

Once the microscope and camera parameters are set, they should not be modified for the rest of the
measurements. Only adjustment of the focus between one channel and the other is allowed. It is advised to
work with the channels from left to right to avoid any confusion, and to mark used channels in proximity of
the inlet at the end of each measurement. Follow the steps described below.

a.

Before starting a measurement, open the camera software and create a folder to save the
images. It is recommended to create one folder for each measurement: one main folder for the
particle type (numbered with the replicate, e. g. M1-rl), and inside three folders named with the
collector type (TO, T4 and T5). The path to the folder should then be in the format: ..\ILC
Hydrophobicity Results\Sample code\Sample code-replicate number\Collector type.

Set up the camera to record 1 image every 30 s for 12 min, for a total of 25 images.

First, adjust the focus on the central line of the left channel, then place the channel chosen
for the experiment under the objective.

Take the collector from the microscope stage paying attention not to move the stage (if it is
necessary to modify the horizontal and vertical position of the stage to get the collector, the original
position in focus must be recorded to reach it back quickly).

Vortex the particles dispersion for 30 sec and fill the selected channel with 20 pL of sample
with a micropipette. For an optimal channel filling, it is important to place the tip of the
micropipette at the vertical (50° from the surface) inside the loading well and lean on the
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well’s bottom. The user should be able to see by naked eyes the liquid flowing inside the cell until
coming to the surface of the outlet. If the loading well seems to be filled and not the channel, the
liquid can be pipetted back and injected again carefully following the instructions on tip position.
Verify that no air bubble is trapped inside the channel. When the sample reach the outlet, the liquid
should be slightly taken back without drying the surface, the injection is then pursued until all the
sample is injected, and the tip removed.

Place the collector back on the microscope stage, at the original position. Adjust the position of
the stage so that the line is visible at the bottom of the field of view, and re-adjust finely the
focus (you can use the zoom on the camera software to be well focused). If available, the autofocus
option of the microscope can be used.

Start recording the images (frame recording rate: 30 s, acquisition duration: 12 min, total number
of images: 25. The 25 images are automatically saved in the chosen folder. Remember to mark the
used channel at the end of the measurement. For a good reproducibility of the measurement, the
time between injection of the sample and the registration start should be kept as short as possible
(possibly < 1 minute).

For the next measurement on the same collector, move the stage horizontally along the central line
to bring the next channel under the objective. The line will be out of focus because of the
different media in the channels (in air or in liquid). When the new sample will be injected, the images
on the screen should be close to focus and adjusted again finely after zooming on the middle line.

Repeat the sample filling operation following the same procedure.

When measuring on a different collector, repeat the quality check on the first channel on the left
side.

The same procedure is followed for each measurement. If possible, the sample should be tested on the three
different collectors on the same day. The measurement (on the three collectors) is then performed in triplicate
for each sample (9 measurements in total per sample). In each Sample Folder, the user should then obtain
three folders for the replicates (rl, r2, r3) and inside each of them, three folders for the different surfaces
(TO, T4 and T5) each containing 25 images as presented in figure 4.

| ILT Hydrophobicity Results

M1 M2 M3

M1-rl M1-r2 M1-r3

lTO lT4 |T5

Figure 4. Chart of the result folders to obtain

Image analysis

The image analysis is performed with the software Fiji and its TrackMate plugin. A USB drive containing the
right version of both the software and the plugin will be provided, together with macros simplifying the
analysis and example images. The analysis consists in an automatic detection of the particles for each frame,
and the tracking of their positions within the sequence of frames. The objects not moving for more than two
frames in a row counting back from the last frame (meaning that they are present at 12 min of analysis) are
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counted. This automatic calculation permits to obtain the number of bound particles per unit of time,
corresponding to the velocity of adsorption of the material on the collector. The macro produces a file that is
saved and imported in Microsoft Excel ® for data treatment and fitting. The analysis is done on six different
area for each image sequence for statistical analysis.

Before starting the analysis, you need to install the macros. To do so, in the Fiji Plugins tab, select Macros
and Install. Select the .txt file Hydrophobicity in the Tools for data treatment folder of the USB drive and Open.
You can then follow the steps described below.

a.

Open the image sequence corresponding to the measurement: Open Fiji, File = Import = Image
sequence. Select the folder in which the measurement was saved: ..\ILC Hydrophobicity
Results\Sample code\Sample code-replicate number\Collector type. Double click on the first image
and choose the Sequence Options: Number of images 25 ; starting image 1 ; increment 1 ; scale
image 100% ; file name contains *leave empty* ; tick Convert to 8-bit Grayscale and Sort names
numerically. A sequence of 25 images should open, named as the folder in which the images are
saved.

To process the image stack for a better detection of the particles, use the macro in Plugins =
Macros =» Initimage. Saturated pixel % is fixed at 0.3 by default, click OK. If your image contrast is
not high enough (it depends on the collector and the material tested), re-launch the macro putting a
higher value (from 0.3 to 3%, you can modify for higher values but not lower than what you
previously put, so use small incrementing steps).

A yellow square has appeared as well as the ROl manager. Position the square manually for
particle and track detection. To do so, double click on the ROI selection and drag then the yellow
square in a “clean area”, where there is no light artefact (use the rectangle tool to be able to click
and drag the square). Do remember that you will have to do the same six times, placing the square in
six different areas. It is then recommended to move the square from left to right and top to bottom
to cover the surface as much as possible.

Launch the second macro using Plugins =» Macros = TrackMateAnalysis to duplicate the
chosen area and start the Tracking. Give a name to the stack: the name of the collector (TO, T4 or T5)
and a number for this duplicate (to increment for the next area, from O to 6), TO-1 for instance.

A window appears to confirm that Z/T will be swapped, click Yes. The macro will process the images
and when the computation is over the Log window should display the computation time as the last
line. TrackMate v5.0.2 window should appear on display options with a button Analysis. On your
Treated stack, if particles are present, they should be surrounded by a pink circle, and some colourful
lines or dot should have appeared inside. You can close the Log window and look at the stack. If
the particles and pink circles are moving when changing frame, and the ones immobile present a line
(or dot) inside, your automatic analysis is done and you can follow directly point g, if not follow
the steps in f.

On the TrackMate window presenting Display options, click on the left arrow until you reach the LoG
detector. Here you can modify the estimated blob diameter and threshold and click preview. Adjust
the parameters until you have pink circles around the particles. Click on the right arrow Next and go
to the Simple LAP tracker. Adjust the two first parameters, click next and check if the visible particles
close to immobility present a line or dot. If not, go back left and adjust again the parameters. When
you are satisfied click Next until you reach the Display options. Follow now the procedure as
described below.

Click on the Analysis button and save the Track statistics window: File = Save As = give the
same name as your stack (e.g. TO-1) and save in the folder corresponding to this replicate (e.g. M1-
rl). You can close the windows with the treated area and all the windows that DO NOT have the Fiji
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icon: the window that you just saved, as well as Links in tracks statistics, spots in tracks statistics, the
two TrackMate v5.0.2 windows and the stack analysed.

You are now back on your Fiji stack with the yellow square. Drag the square in another clean
area and start again point c. Repeat this step until you have saved six .csv files for this
measurement in your folder.

Once six areas have been analysed on the collector, close the main stack window (TO, T4 or T5) and
repeat the procedure starting back from point a. for the other two collectors. Remember to
always keep Fiji opened as it contains the size calibration information. If the opened stack or image
appears as pixel x pixel instead of um x um, the calibration step must be repeated. At the end of the
Image analysis you should have 18 .csv files in your sample-replicate folder: TO-1 to -6, T4-1 to -6,
and T5-1 to -6.

Data treatment

The data treatment and the calculation of the Hydrophobicity Index are not assessed in this ILC.

The main objective of the ILC is to evaluate the reproducibility of the collection of the binding curves.

7. DATA REPORTING

The RESULTS file provided as a template for the Test report should be filled in and sent via JRC-Box after the
test, together with:

the images

the .csv files

8. ESTIMATED TIME

Collectors preparation

Provided ready-to-use by JRC

Nanomaterial samples

3 different samples will be provided by the JRC to the participating laboratories.

Measurement

Setting up of the microscope before starting the test: 15 min

Measuring and collecting images: 15 min per sample (3) per collector (3) per replicate (3)

In total 27 measurements

= Total 7h
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Image analysis

Fiji + Trackmate with macros: 10 min per measurement

= Total 4h30

TOTAL ESTIMATED TIME: 11h30

9. REFERENCE DOCUMENTATION

Desmet et al. (2017), J. Nanopart. Res,, 19: 117
Valsesia et al. (2018), Comms. Chem., 1 : 53

Van Oss et al. (1986), J. Colloid Interface Sci., 111 : 378
Donaldson et al (2015), Langmuir, 31 : 7

Microscope, equipment user’s manual
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Annex 2. Preparation of the material samples

Material 1 and 3

The samples of material 1 and 3 are provided as dispersions in numbered tubes ILT-M1xxxxxxxx and ILT-
M3xxxxxxxx. Prior to the first measurement, they should be sonicated in a sonication bath at a frequency of
40 kHz for 2 min. (The most common sonication bath, which do not provide the frequency adjustment, works
at 40 kHz.) The material should be vortexed for 30 sec just before injection in the fluidic channel, as described

in the main SOP.

Material 2

The material 2 is provided as a concentrated dispersion in the Eppendorf tube ILT-M2. ILT-M2xxxxxx contains
the buffer for final dilution.

The procedure to get the final sample is the following:
A.  Vortex the tube ILT-M2 and sonicate it for 3 min at 40 kHz.
B. Pipette 100 pL of ILT-M2 and add it to ILT-M2xxxxxxxx. Sonicate it for 2 min at 40 kHz

C. Vortex ILT-M2xxxxxxxx for 30 sec before each injection on the collector.

Material 4

The material 4 is provided in powder form. 3 Eppendorf tubes are provided.

&
@

M4-1
M4-2
‘ ILT-M4AX0000(XX ‘

M4-1 contains the material in powder form, the mass is written on the side. M4-2 contains the buffer to use
to disperse the powder. ILT-M4xxxxxx contains the buffer for final dilution, it will become the sample to inject.

The procedure to get the final sample is the following:

A. Pipette the volume of M4-2 to get a 1 mg/mL solution in M4-1 (if M4-1 is 1.3 mgq, pipette 1300 pL from
M4-2). Vortex for 1 min, sonicate for 5 min at 40 kHz
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B. Vortex for 1 min. Pipette 10 pL from M4-1 and add it to ILT-M4xxxxxxxx. Do not forget to vortex for 30 sec
before each injection.

Material 5

The material 5 is provided in powder form. 3 Eppendorf tubes are provided.

\

gy

M5-1
M5-2

ILT-M5XXXXXXXX i </

M5-1 contains the material in powder form, the mass is written on the side. M5-2 contains the buffer to use
to disperse the powder. ILT-M5xxxxxx contains the buffer for final dilution, it will become the sample to inject.

The procedure to get the final sample is the following:

A. Pipette the volume of M5-2 to get a 1 mg/mL solution in M5-1 (if M5-1 is 1.3 mg, pipette 1300 pL from
M5-2). Vortex for 1 min, sonicate for 5 min at 40 kHz

B. Vortex for 1 min. Pipette 10 pL from M5-1 and add it to ILT-M5xxxxxxxx. Do not forget to vortex for 30 sec
before each injection.
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